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1. Quick Start Tutorial 

What is it about? 

This is a step-by-step quick example demonstrating how to create a customer, a 

product and an invoice in Invoice Manager for Excel.  

For a short movie tutorial, see how to create an invoice. 

Steps 

The screen shots in this tutorial are taken on Windows 10 and Excel 2016. 

1. Open your template using the shortcut on Windows desktop. If you use 

the standard template shipped with Invoice Manager for Excel, it connects 

with the default "Sample.mdb" database.  

2. Click and activate the Invoice worksheet if it is not activated yet.  

 

3. Click the Customers button on the Invoice worksheet to open the Customers 

window.  

https://www.invoicingtemplate.com/#create-invoice
https://www.invoicingtemplate.com/standard.html
https://www.invoicingtemplate.com/images-doc/invoice-template-uis.png
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4. Click the Add Customer button on the Customers window.  

5. Fill in your customer information in the New Customer window. This 

window provides a number of fields. Only the Name field is required. The 

name can be either a person's name or a company name, such as "Uniform 

Software LTD". Click Save button to save this customer. The window 

caption changes to Customer Edit, and a customer ID is generated 

automatically if left blank.  

 

https://www.invoicingtemplate.com/images-doc/customers.png
https://www.invoicingtemplate.com/images-doc/customer-edit.png
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6. Press the Esc key twice to close the Customer Edit window and Customers 

window.  

7. Click the Products button on the Invoice worksheet to open the Products 

window.  

 

8. Click the Add Product button to open the New Product window.  

Fill in the description, price and stock information in this window. Click the 

Save button to save the new product. 

https://www.invoicingtemplate.com/images-doc/products.png
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9. Press the Esc key twice to close the Product Edit and Products window.  

10. Now it's time to create your first invoice. On the Invoice worksheet, click 

any cell inside the "Bill To" section, the "on-sheet picker" button appears. 

Click it to open the Customers selection dialog box, double click the 

customer name "Uniform Software LTD" to select this customer into the 

Invoice worksheet.  

https://www.invoicingtemplate.com/images-doc/product-edit.png
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Note: If you know the ID value of the customer, you can also enter the ID 

value into the Customer ID cell to fill customer information into the "Bill 

To" section. This feature is called "In-Cell Lookup".  

11. Click any cell on the first line of the invoice detail section, the on-sheet 

picker button appears. Click it to show the Products selection dialog box.  

You can double-click an item to fill the product information into the Excel 

worksheet. To select multiple products, select an item and then click "Add 

Item" to add the item to the selection. Repeat this to add all items. Once 

done, click "Close" to fill all the products in the selection into the Excel 

worksheet. 

Tip: You have a long product list, use the Search bar to locate products 

quickly. 

https://www.invoicingtemplate.com/images-doc/customer-select.png
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Tip: If you know the ID value of the product, you can also enter the ID 

value into the Product ID Excel cell to retrieve all the product information.  

 

12. Fill in or change Quantity and Unit Price if necessary.  

13. Click the Save To DB button on the Invoice worksheet to save the invoice. 

An invoice ID is generated automatically if left blank.  

14. If you want to print the invoice, just click the Print button on the Invoice 

worksheet.  

To send the invoice to the client using email, click the "Extract / Email" 

button. 

That's it! You have successfully created a new invoice! 

2. How Invoice Manager for Excel Works 

The core of an invoicing system powered by Invoice Manager for Excel is an add-

in program that runs inside Microsoft Excel. On the front-end, you see and work 

with an Excel-formatted invoice template with many buttons on the task pane 

and ribbon, like "Customers", "Products", and "Invoices". The add-in program 

connects the invoice template with a backend database for storing and 

organizing data. 

https://www.invoicingtemplate.com/excelinvoicetemplatewithautomaticnumbering.html
https://www.invoicingtemplate.com/printable.html
https://www.invoicingtemplate.com/invoicetemplateemail.html
https://www.invoicingtemplate.com/images-doc/product-select.png
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With this architecture you benefit from both two mature technologies. 

▪ The Excel-formatted invoice template gives you an intuitive invoice form 

to work with. It's easy to create an invoice even you are new to any 

invoicing program. 

▪ The backend database gives you a central and organized way for storing 

large amount of data. Invoice Manager for Excel uses mature and public 

database format, including Microsoft Access and SQL Server. We don't use 

private database formats and don't hide your data from your eye. You 

have full control on your data.  

▪ The add-in program runs inside Excel, leveraging the power of Excel 

spreadsheets and backend database. 

All the powerful Microsoft Excel tools are all available to you for further 

customizing the invoice template.  

You may have very special requirements about the invoices you create. Invoice 

Manager for Excel allows you to use your familiar Excel tools to adjust fonts, 

colors, borders, patterns, and even formulas to do calculations and create 

relationship between cells/fields.  

If you prefer to put a field on another location, or don't need it at all, you can do 

this by simply dragging and dropping it. 

If you need new fields to further detail the goods and services you provide, use 

custom files. 

3. Before Using a Template - 

InvoicingTemplate.com  

Contents 
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▪ Logo image and company information 

▪ Taxes 

▪ Creating a new database (optional) 

Logo image and company information 

If you have installed Invoice Manager for Excel version 4.12 or higher versions, 

click the "Replace Logo Image" button on the "Invoice" ribbon tab and follow the 

wizard to specify your own logo image. That's all you have to do! 

If you're using an earlier version of Invoice Manager for Excel prior to 4.12, to 

replace the default LOGO image manually and enter your company information 

on the Invoice worksheet: 

1. Open your invoice template in Microsoft Excel.  

2. Switch to the "Invoice" worksheet if it is not active (or is not the current 

worksheet). Switch to the Invoice ribbon tab if it is not activated.  

3. If you are running an earlier version of Invoice Manager for Excel that does 

not provide the "Replace Logo Image" command, now you should 

unprotect the "Invoice" worksheet.  

By default, the "Invoice" worksheet is protected to avoid overwriting 

formulas accidentally. To unprotect it, in Excel 2007/2010/2013/2016 click 

Review tab / Changes group / Unprotect Sheet. 

4. Switch to design mode by clicking the "Design Mode" button on the 

Invoice ribbon. 

5. On the "Invoice" worksheet, enter your company information to replace 

the default text labels, such as your company name, address, and contact 

information.  

6. To further customize your logo image, or to add / replace the logo image 

manually, follow the steps below:  

a. Right click the Logo image, and select Properties from the menu.  
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b. Click the Picture property, and then click the ... button.  

 

c. Browse to the folder containing your icon file. Select and open the 

icon file. 
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d. Close the Properties dialog box. 

e. Drag the border of the image object to resize it, if needed.  

If you don't need the LOGO image, follow the steps below. 

I. Click the LOGO image to select it. 

II. Hit DEL key on your keyboard. 

III. Deleting the LOGO image leaves an empty area to the left of 

the Company Information section. You may like to move the 

entire Company Information section to fill in the empty area. 

To do this: Drag your mouse to select the entire Company 

Information area, including Company Name, Street Address, 

City, ST Zip Code, etc.; Push your mouse key on the border of 

the selected area; drag it to the new location.  

f. Exit design mode, by clicking the Design button again. 

g. Protect the Invoice worksheet.  

In Excel 2007/2010/2013/2016, you can find the command in the 

Changes group of the Review ribbon tab. 

h. Save your invoice template by clicking Office button -> Save in 

Excel 2007, or by clicking File -> Save in Excel 2010 and 2013/2016. 

Refer to Invoice Template with Logo for more options about the logo image. For 

more information about customizing the invoice template, please see 

Customizing Invoice Template. 

Taxes 

Settings the number of taxes, for example changing from two-tax to one-tax, is 

implemented by hiding the tax rows on the worksheet. If you choose "One Tax", 

the first tax row identified by the "oknTax1" name is visible; if you choose "Two 

Taxes", both the rows identified by "oknTax1" and "oknTax2" names are visible. 

This works well with the default invoice template shipped with Invoice Manager 

for Excel installer program, where the "oknTax1" and "oknTax2" names are put on 

two separate rows and no other critical content are located there. 

However if a template is deeply customized, for example the "oknTax1" and 

"oknTax2" names are moved to one row, or other fields are put on the rows 

where the "oknTax1" and "oknTax2" name reside, the feature of setting the 

https://www.invoicingtemplate.com/invoicing-template-with-logo.html
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number of taxes may not work properly. In this case, you need to customize the 

taxing cells manually by making the rows hidden or visible, or by moving the cells 

inside or outside the printable area. 

To set up the taxing rules using the "Settings" window, follow the steps below.  

1. Click Settings button on the Invoice worksheet to open the Settings window.  

2. Click Taxes.  

 

3. Choose your tax system: No Tax, One Tax, or Two Taxes. If you have 2 

taxes, click the option Tax2 is applied to tax1 so tax2 is calculated on the 

sum of the price+tax1. Fill in your tax names and percentages in the 

appropriate text boxes.  

4. Click Apply.  

5. Close the Settings window and return to Excel.  

6. Click the Save button on the Excel toolbar to save the modified workbook.  
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Additionally, each product has a Taxable attribute that controls whether the tax 

rate will be applied to the product. For each invoice, you can also set its tax rates 

and Taxable attributes.  

Creating a new database (optional) 

On a fresh installation, the default invoice template is connected with the 

sample.mdb database. This database is installed for demonstration purposes. You 

can use this database to try out how Invoice Manager for Excel works. After 

reviewing and testing the software, you will want to create a new database for 

your own data. To create a new database, follow the steps below:  

1. On the Invoice worksheet, click the Settings button to open the Settings 

window.  

2. Click the Database tab.  

 

3. Click Create new database under the Access Database tab.  

4. Select a folder to store your new database file and enter the database file 

name. Click Save to create a new database file.  
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5. If you want to open the newly created database for current workbook, 

click the Open database button under the Access Database tab. Then select 

the database file you just created.  

6. If the database is successfully opened, the database name will be 

displayed below the Current Database label on the Invoice worksheet.  

7. The full path and file name of the database is stored in a hidden cell in the 

workbook. To make the workbook connect to/open the new database 

automatically next time you open it, click the Save button on the Excel 

toolbar to save the workbook.  

4. Template File Format 

Starting with 2007 Microsoft Office system, Microsoft is introducing new file 

formats for Word, Excel, and PowerPoint, known as the Office Open XML formats. 

In Office Excel 2007, the default format for an Excel workbook is the Office Excel 

2007 XML-based file format (.xlsx). 

Most of our invoice templates available on UniformSoft.com are in ".xls" format. 

You can open and work with the template directly in Excel 2007, Excel 2010 or 

Excel 2013, without any problems, but the title bar of Excel window displays the 

words "[Compatibility Mode]".  

If you don't need to move the template to other computers that are running 

previous versions of Excel, you can save it in the following new formats supported 

by Excel 2007 or the later versions.  

File extension Format 

.xlsx Excel XML-based file format 

.xlsb Excel Binary (or BIFF12) file format 

.xlsm Excel XML-based and macro-enabled file format 

To convert a template into a new format:  

1. Open the template in Excel 2007~2013.  

2. In Excel 2007 click the Microsoft Office Button located in the up-left corner 

of Excel's main window; or in Excel 2010 and 2013, choose File.  

3. Click Save As.  

4. Click Yes on the warning message dialog displayed by Invoice Manager for 

Excel.  

5. Choose a file format in the Save As dialog. Enter your new file name, say 

"Invoice Template ".  
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6. Click Save to save the template.  

5. Install / Upgrade 

New installation 

If you run the setup program of Invoice Manager for Excel (invoice-manager.exe) 

in a Windows system for the first time, or you have removed/uninstalled Invoice 

Manager for Excel before running the setup program, you are performing a fresh 

new installation.  

Program files 

Invoice Manager for Excel supports both 32-bit and 64-bit platform. The setup 

program chooses the correct edition (32-bit or 64-bit) based on the Office 

edition installed on the system.  

That is, if your Windows and Office are all 64-bit, Invoice Manager for Excel 

appears as a 64-bit program and by default installed in the following program 

folder: 

 

<System Driver>\Program Files\InvoicingTemplate.com\Invoice Manager 

for Excel 

If your Office is 32-bit and Windows is 64-bit, the program files are store in: 

 

<System Driver>\Program Files (x86)\InvoicingTemplate.com\Invoice 

Manager for Excel 

If your Windows and Office are all 32-bit, the program files are stored in: 

 

<System Driver>\Program Files\InvoicingTemplate.com\Invoice Manager 

for Excel 

Data files 

The setup program installs a default template and a database file into the data 

file folder. By default, the data file folder is: 

https://www.invoicingtemplate.com/invoice-manager.exe
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<commondocs>\Invoice Manager for Excel\ 

So for example on Windows 8 it usually appears as: 

 

C:\Users\Public\Documents\Invoice Manager for Excel\ 

If you are running Excel 2007 or higher versions, the default invoice template will 

be in '.xlsx' format; and if your Excel is 2003, the default template will be in '.xls' 

format. 

Upgrade 

If you upgrade from Invoice Manager for Excel to Invoice Manager for Excel, the 

setup program keeps your original files (both data files and program files), but 

breaks the links between the program and Excel. That is, Invoice Manager for 

Excel will no longer work. If you open an invoice template that works with Invoice 

Manager for Excel, now it will work with Invoice Manager for Excel. 

If you have a previous installation of Invoice Manager for Excel installed, and 

want to upgrade to the latest version, here are the three situations that can occur 

when you run the setup program without removing the previous version in the 

first place.  

1. You install the program to the same folder as the previous version, and 

choose "NO - Do not overwrite my data" option on the Upgrade Existing 

Program screen.  
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This is the default installation mode if you don't change any option in the 

setup program and accept all the defaults. This way, you won't lose any 

data saved with the previous version. However, if you already have a NEW-

DATA-FILE subfolder inside the data file folder, the following files will be 

overwritten without any warning message:  

Data Files in the NEW-DATA-FILE folder 

 

NEW-DATA-FILE\INVOICE.xls (or the .xlsx version) 

NEW-DATA-FILE\Sample.mdb 

All the shortcuts, including those on the Windows Start menu and 

Desktop, will point to the existing files, but not the files inside the NEW-

DATA-FILE folder. 

If there is already a shortcut named "Invoice.xlsx" on Windows desktop, it 

will be kept. A new shortcut will be created for the files in the NEW-DATA-

FILE folder. The new shortcut will have a name like "Invoice.xlsx-

yyyymmdd", where yyyy, mm and dd is the year, month and day of the 

current date. 
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2. You install the program into the same installation folder and data file 

folder as the previous version, and choose YES - I want to overwrite all 

existing data files option on the Upgrade Existing Program screen.  

In this case, all the data files listed in the above table will be overwritten. If 

you were using the Sample.mdb database file in the data file folder as the 

working database, you will lose your data.  

3. You install the new version to a different folder than the one where the 

previous version was installed.  

The installer will upgrade all your program files, and copy all the data files 

listed in the above table to the new folder. All the shortcuts created by the 

installer, including the ones on the Windows Start menu and Desktop, will 

point to the files in the new folder.  

All the data files you saved with the previous version will remain there. To 

use your original template and database, just go to the folder where you 

stored your template, and then open the template file.  

Uninstall Invoice Manager for Excel 

To uninstall Invoice Manager for Excel, open Windows Control Panel, and then 

"Uninstall a program" (Windows 8 and Windows 7). Choose "Invoice Manager for 

Excel" in the program list, and then click "Uninstall". 

6. Settings - Template 

Click the Settings button on the Invoice worksheet to open the Settings window. 
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(Figure taken on Windows 10) 

Before Closing Invoice Template 

In an Invoice Manager for Excel system, the invoice template is also used as a 

temporary work area, and the COM add-in constantly reads from and writes to it, 

sometimes even without your knowledge. For example, if you try to print an 

invoice from the database, it will write the invoice data to the Invoice worksheet.  

So, to keep your workbook clean, Invoice Manager for Excel provides these If the 

invoice template has been modified options:  

Option Action 

Prompt for saving 

changes 

Excel's default behavior. This option is selected by 

default. 

Save changes 
Saves changes automatically whenever you close an 

invoice workbook. 

Discard changes Discard changes automatically. 

Note: These options apply to invoice workbooks only. They don't affect other 

workbooks.  
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The Invoice worksheet is designed in a way that can be run in the protected 

mode. It is highly recommended that you protect the Invoice worksheet once you 

finish your design or customization. Invoice Manager for Excel checks the status 

of protection every time you close the template, which you can control by using 

the "If the Invoice worksheet is not protected" option detailed below: 

Option Action 

Display a warning 

message 

Display a warning message if the Invoice worksheet is 

not protected. 

Protect Invoice 

worksheet 

automatically 

Don't display the warning message. Protect the 

Invoice worksheet automatically. 

Ignore Don't check the protection status. 

Saving Invoice 

The first two options tell Invoice Manager for Excel what to do after saving a new 

invoice (i.e. after clicking the Save To DB button on the Invoice worksheet).  

Option Action 

Prompt for payment 

If you select this option, Invoice Manager for Excel 

displays a New Payment window after saving an 

invoice to the database. 

Clear invoice 

worksheet 

If you select this option, Invoice Manager for Excel 

clears the Invoice worksheet, so you can start to enter 

the next invoice. 

Line totals can be zero 

(This option is removed since version 5.24) By default, 

all line items with zero line totals are counted as 

invalid. If you check this option, these line items are 

valid and can be saved to the database.  

Allow incomplete line 

on invoice body 

(This option is removed since version 5.24) Allows you 

to save incomplete lines to the backend database.  

ZIP/Postcode in 

separate cell 

If you check this option, when you click the Save To 

DB button the ZIP/Postcode is read from separate 

cells, which is named oknWhoZipPostcode in the Bill 

To section, and oknShipZipPostcode in the Ship To 

section. When you try to display an invoice, the 

ZIP/Postcode values go into these cells too.  
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Update customer on 

saving new invoice 

Instructs Invoice Manager for Excel to execute the 

Save As New Customer command whenever a new 

invoice is about to be saved. If the customer 

identified by the Customer ID does not exist, a new 

account will be created automatically. If the customer 

account already exists, only customer information will 

be updated.  

Disallow negative 

product stock  

Enabling this option raises an error/warning message 

when the inventory quantity on hand falls below the 

quantity on the current invoice.  

Include time with 

invoice date  

By default, Invoice Manager for Excel does not store 

the time information in the invoice date field. If this 

option is checked, the invoice date field will be able 

to store the time part of an invoicing date. Note that 

checking this option does not alter your invoice 

template automatically - you'll need to format the 

invoice date cell to accept / display time information. 

To do this: 

1. Switch the invoice form into design mode by 

pressing the "Design Mode" button on the 

"Invoice" ribbon tab. 

2. Right-click the invoice date cell, choose Format 

Cells from the shortcut menu. 

3.  On the "Number" tab, click "Date" in the 

"Category" list, and then click "Custom". This 

displays common date/time format 

combinations in the "Type" list. Choose one, or 

create a customized one as you needed. 

4. Once you have specified the date/time format 

for the "Invoice Date" cell, exit design mode by 

clicking the "Design Mode" button again on 

the "Invoice" ribbon tab. 

5. Save the invoice template by clicking Excel 

menu File / Save. 
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7. Settings - Taxes 

Click the Settings button on the Invoice worksheet to open the  

Note: The options on this page apply to the default invoice template. A 

customized invoice template, such as the one you download from 

InvoicingTemplate.com, may implement a very special taxing system and thus 

does not support the options available on this page. 

Settings window.  

 

The options on the Taxes tab control how the workbook calculates taxes. You can 

choose No Taxes, One Tax, or Two Taxes. The tax name is a description string for 

the tax charges (GST, VAT, etc.), and it will appear on your invoices and reports. 

The tax rate (a percentage) here is a default value that will be used to update the 
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tax rate value on the Invoice worksheet each time you click the Clear & New 

button.  

Option Action 

Tax invoice 

total including 

shipping cost 

Tax 1 and tax 2 are calculated on the sum of the Subtotal + 

Shipping Cost 

Tax 2 is 

applied to tax 

1 

Tax 2 is calculated on the sum of the Subtotal + Tax1 

Tax rate can 

be zero 

By default tax rates cannot be set to zero. If you check this option, 

you can set the tax rates to zero. This is useful if most of your 

customers do not have sales tax, but a few do.  

You still can set the tax rates on a per-invoice basis when creating 

invoices, by entering the tax rates directly into the cells named 

oknTax1Rate and oknTax2Rate. However, this applies to the 

standard template only. If you are using a customized version of 

the template, the per-invoice tax rates feature may not work 

properly.  

Invoice Manager for Excel supports many different invoice layouts / forms. Some 

of the customized forms have their own tax calculation rules. For example, a 

template may calculate taxes based on product category or type, or based on 

customer type/category. Browse our online template directory for more 

information. 

8. Settings - Misc. Data 

Click the Settings button on the Invoice worksheet to open the Settings window.  

http://www.uniformsoft.com/


 

INVOICE MANAGER FOR EXCEL   INVOICINGTEMPLATE.COM 

25 

 

This tab provides a tool to manage all miscellaneous data. You can set default 

values, as well as edit all miscellaneous data tables.  

The default values you set on this tab are applied to database. That is, for each 

different database, you can set a different group of default values.  

To edit a miscellaneous data table, click the corresponding Edit button. For 

example, if you want to edit Customer Categories, click the Edit button near the 

Default Customer Category label. This will open the Customer Category window, 

where you can add, edit, or delete customer categories.  

9. Settings - Database 

Click the Settings button on the Invoice worksheet to open the Settings window. 
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The Database tab is where you can create new databases, connect the current 

workbook to a specified database, and define rules for generating IDs. 

The Enterprise edition of Invoice Manager for Excel supports two types of 

database, Access and SQL Server. To connect the template to an Access database 

file, click Open database button under the Access Database tab. To share data with 

others on a Local Area Network, choose a common location to store the database 

file. 

Create or connect to database 

To create a new Access database: 

1. Click the Create new database button under the "Access Database" tab. 

2. Select the folder to store you database file, then enter the database file 

name, and then press Enter. Note: You must have read and write access to 

the destination folder.  

3. An empty new database will be created.  

To open an existing Access database: 
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Opening a database means connecting the current template to a different 

database. The information about which database the workbook is connected to is 

stored in the template. After opening a database, it is very important for you to 

Save the template if you desire the template to open the database automatically 

next time you open the workbook.  

1. Click the Open database button under the "Access Database" tab. 

2. Browse to the folder where the database file is located and select the 

database file.  

3. If successful, the Settings window will close. 

To create a New SQL Server database: 

1. Click Refresh on the "SQL Server Database" tab. 

2. The "Server Name" list shows all the SQL servers available to this 

computer. Click and choose the server name you want to use. 

3. Click the Create new database button, and then specify the database name. 

To connect to an existing SQL Server database: 

1. Click Refresh on the "SQL Server Database" tab. 

2. The "Server Name" list shows all the SQL Servers available to this 

computer. Click and choose the server name you want to use. 

3. Select the database you want to use from the "Select a database" drop-

down list box. 

4. Click Connect to this database. 

Rules for Generating IDs 

Although you can enter new IDs by yourself when creating new invoices, 

products, and customers, you can also leave the ID fields blank and the system 

will generate IDs for you. The following rules specify how the system generates 

new IDs when necessary. These rules are intrinsic to the database, so each 

database can have its own specific rules.  

An ID value is comprised of two parts: a prefix string, and an integer. The Number 

of digits in ID value specifies how many digits the integer value has. For example, 

if the Prefix String is A, the Next Number is 1028, and the Number of digits in ID is 5, 

the next generated ID will be A01028.  
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10. Settings - In-cell Lookup 

Click the Settings button on the Invoice worksheet to open the Settings window.  

 

The In-Cell Lookup feature allows you to retrieve a customer, a product or an 

invoice by typing the corresponding ID value right within the Invoice worksheet. 

For example, if you want to enter information about a product, which has an ID 

value of "345789", into the second line of the invoice body, all you need to do is 

to type "345789" into the "Product ID" cell on that line. 

The in-cell lookup feature is also useful for users who use barcode as the product 

IDs. Simply activate/click the cell in which you want to place the product ID, and 

then scan the barcode as usual. You don't need to bring up the product selection 

box again and again.  

11. Settings - Print 

To print an invoice in Invoice Manager for Excel, simply click the Print button on 

the Invoice worksheet. It also allows you to print invoices in the regular Excel way 

– you can print invoices by clicking Excel menu File / Print in Excel 2003, or by 
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clicking Office button / Print in Excel 2007, or by clicking File menu / Print in Excel 

2010 and Excel 2013. You can also use the Print Preview feature of Excel to have a 

look at the printed invoice before it is actually printed. 

Print tab on Settings dialog box 

The Print dialog tab on the Settings window in Invoice Manager for Excel offers 

additional options beyond what included in Microsoft Excel. To open the Print 

tab: 

1. Click the Settings button on the Invoice worksheet. 

2. Click Print. 

 

Option Action 

Print 

automatically 

when Save To DB 

is clicked 

If this option is checked, Invoice Manager for Excel prints 

the current invoice automatically when you click the Save 

To DB button.  

In the default process of creating an invoice, you first pick 

a customer, then fill up products and services, then click 

Save To DB to have the program generates an invoice 

number (invoice ID), and then click Print to print the 
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current invoice. If the option "Print automatically when 

Save To DB is clicked" is checked, Invoice Manager for 

Excel prints invoice automatically so that you don't need 

to click the Print button again. 

By default the option is unchecked. 

New invoices only 

This option is disabled by default. It is available only when 

"Print automatically when Save To DB is clicked" is 

checked.  

If you check this option, "Print automatically when Save To 

DB is clicked" is applied to new invoices only. If you 

update an existing invoice, Invoice Manager for Excel 

won't print it automatically. 

Show Excel Print 

dialog box before 

printing 

Display Excel Print dialog box before printing. The Print 

dialog box allows you to select the printer to use, set the 

number of copies to print, etc.  

Default printer 

By default Invoice Manager for Excel prints using your 

default printer set in Microsoft Excel or Windows. If you 

have more than one printers installed, and the printer for 

printing invoices is different from the default Windows 

printer, use this drop-down list box to select the printer 

for printing invoices.  

The default printer you select here applies to Invoice 

Manager for Excel only. It does not affect the default 

printer settings in Microsoft Excel or Windows 

.  

Print_Area and Print_Title 

When you click the Print button on the Invoice worksheet, Excel prints out the 

center area of the invoice form, instead of the entire sheet. The printable area is 

identified by a range name Print_Area. So, if you don't want a cell (or a range of 

cells) to appear on the invoice form and printed invoices, you can simply move 

the cell or cells out of the printable area. 

For example, let's say you don't want the cells oknBalanceDue and oknPayments 

and their corresponding labels, "Paid" and "Total Due" to appear on the printed 
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invoices, you can move these cells out of the ,Print_Area by following the steps 

below: 

1. Unprotect the Invoice sheet if it is protected. (How?) 

2. Drag your mouse to select all the cells that you want to move. 

3. Push your mouse key on the border of the selected area, drag it and drop 

it on an unused area. 

4. Now if you preview the printed invoice form, the 4 cells won't appear. 

5. Protect the Invoice sheet. (How?) 

ActiveX controls added to the invoice templates, such as those buttons, images, 

can be customized in a similar way - The only difference is that to move or delete 

an ActiveX control, you need to switch to template to design mode. To find out 

how to switch to design mode, please see Customizing Invoice Template. 

Generally you don't need to modify the settings of the Print_Area and Print_Titles 

range names. But if you need to do this, there are several ways to do it in Excel. 

To create or set the print area: 

1. Unprotect the Invoice worksheet if it is protected. 

2. Drag your mouse to select the range that you want to print. 

3. Click Excel menu File / Print Area / Set Print Area in Excel 2003; if you are 

using Excel 2007/2010/2013, go to the Page Layout ribbon tab, click Print 

Area in the Page Setup group, and then choose Set Print Area. 

The above steps allow you to set only the Print_Area range. To set the Print_Title 

range, which is repeated on the top of every page when you print the form, go to 

the Page Setup dialog box: 

1. Click Excel menu File / Page setup in Excel 2003, or click the Print_Titles 

command in the Page Layout ribbon tab in Excel 2007/2010/2013. 

2. Click the Sheet tab. 

3. Specify the rows you want to repeat in the Rows to repeat at top box. 

4. Click OK to close the dialog box. 

At some point you may need to delete the print area - i.e. to get rid of the special 

area designation, not the information contained within that area, so that, for 

example you can start again to define a new printable area. To do this: 
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1. Choose Excel menu Insert / Name / Define in Excel 2003; or in Excel 

2007/2010/2013, first make sure the Formulas tab of the ribbon is 

displayed, and then in the Defined Names group, click Name Manager. 

2. Look in the list of defined names for one called Print_Area or Print_Titles. 

This is the definition of your print area or print title. (If you don't see an 

entry by this name, there is no print area or print title defined in the 

current sheet.) 

3. Select the name, and then click on Delete. 

4. Click on Close to close the dialog box. 

Excel page setup dialog box 

Excel's Page Setup dialog box provides many options for customizing how the 

invoice form could be printed. After customizing the invoice form, you may like 

to take a look at the dialog box and adjust the options, to make the invoice more 

printable. 

All the Excel versions, including Excel 2003/2007/2010/2013, provide the Page 

Setup dialog box. Although the different Excel versions provide slightly different 

options, and the available options may vary by operating system and printer 

model, the main part keeps consistent. Refer to your Excel documents for more 

detailed and accurate explanations on the options you can use. 

12. Settings - Extract / Email 

Click the Settings button on the Invoice worksheet to open the Settings window. 

The Extract / Email page controls how the Extract / Email button on the task pane 

(shown when the Invoice worksheet is active) works. 



 

INVOICE MANAGER FOR EXCEL   INVOICINGTEMPLATE.COM 

33 

 

Extract invoice only. Don't send invoice with email 

If you choose this option, the Extract / Email button on the task pane extracts the 

current invoice and place it on a separate Excel file. The extracted workbook is a 

free copy, that is, it is outside Invoice Manager for Excel and you can do anything 

with it. For example, you can email it out, add or delete data, or simply do some 

formatting.  

Option Action 

Remove hidden rows 

and columns after 

extracting report 

The reports you created usually contain too many 

columns. Though you can use the Columns button to 

hide some of the columns, they still exist on that 

worksheet. You can use this option to remove the 

hidden rows and columns from the extracted report 

worksheet. 

Remove hidden rows 

and columns after 

extracting invoice 

Like report worksheets, the Invoice worksheet also 

contains hidden rows and columns. You can use this 

option to remove them from the extracted copy.  

Copy the page setup 

after extracting invoice 

Page setup here is the options you selected on the 

Page Setup dialog box in Excel 2003 (Click Excel menu 
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File -> Page Setup to open it); In Excel 2007 - 2013, 

you can set these options in the Page Layout tab.  

It sometimes takes one or two seconds to copy all the 

page setup option values from one worksheet to 

another. You can clear this option to speed up the 

extracting operation. 

Protect 

invoices/reports after 

extraction 

Protect the extracted worksheet automatically. Same 

as clicking Excel menu Tools -> Protection -> Protect 

Sheet for the extracted worksheet in Excel 2000 - 

2003, or clicking Review tab -> Changes group -> 

Protect Sheet in Excel 2007/2010. 

Send invoice with email 

If you want to send the invoice to your client when clicking the "Extract/Email" 

button on the task pane that is shown when the Invoice worksheet is active, 

choose the "Send invoice with email" option on the Extract/Email page of the 

Settings window. 

Before you can send invoice to a client with email, make sure the email address is 

correctly filled in on the invoice, or on the customer records. When you click the 

"Extract/Email" button on the task pane, Invoice Manager for Excel first looks for 

an email address on current invoice; and it cannot find one, it then looks an email 

address in the customer record. 

Invoice Manager for Excel is able to send invoice in two formats - PDF format, or 

Excel spreadsheet format. It is recommended to use PDF format, because today 

many email servers could block Excel files (and other Office documents) attached 

to email. 

No matter what invoice format you choose, all the fields in the "Email Server" 

section should be filled in correctly. You can obtain this information from your 

ISP or the email service that you use. Invoice Manager for Excel uses information 

you provided in the "Email Server" section to log into your SMTP email server and 

sends email. 

The "Email from" field is what you customer will see on the "from" field when 

they open your email. 
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The "BCC to" field allows you to specify a BCC email address ("Blind Carbon 

Copy"). This should be one of your own email address. If you specify one, Invoice 

Manager for Excel sends email not only to your client (email address obtained 

from invoice, or customer record), but also to the BCC email address for your own 

records. It is recommended that you fill in this field. 

Click the "Email Template" button to view or edit the content of your invoice 

email. The "##invoiceid##" and "##balancedue##" are two variables - they will be 

replaced with actual values when building an email. 

Click "Send test email" to verify that the options you set on this page works 

correctly. Make sure you clicked the "Apply" button before clicking the "Send test 

email" button. 

If you check the "Request return receipt" option, Invoice Manager for Excel set 

this flag with your email. Note that there is no way to force your clients to return 

a receipt - that is they may choose to not sending the receipt. When delivering a 

message to a recipient's computer system there is no way to force that computer 

system to issue an acknowledgment to the sender. 

13. Customers 

13.1 Add New Customers 

There are three ways to add new customers: A) Using the Customers window; B) 

Using the Invoice worksheet; and C) Copying from an existing customer.  

A) Adding a New Customer Using the Customers 

Window 

1. Click and select the Invoice ribbon tab if it has not already been selected.  

2. Click the Customers button on the Invoice ribbon tab to display the 

Customers window. This window displays all customers in the database.  
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3. Click the Add button.  

4. In the New Customer window fill in your customer's information. The only 

required field for a customer is the Name field. All other fields are optional 

and a customer ID is automatically generated if one is not filled in.  

5. Click Save Changes button to save this customer. If succeeded, the New 

Customer window becomes the Customer Edit window.  

 

B) Creating a New Customer Using the Invoice 

Worksheet 
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1. Click and select the Invoice worksheet if it isn't already selected.  

2. Fill in your customer's information in the appropriate field near the Bill To 

label. Again, the only required field for a customer is the Name field. All 

other fields are optional and a customer ID is automatically generated if 

one is not filled in.  

3. Click the Save As New Customer button on the task pane to create the 

customer.  

C) Creating a New Customer by Copying an Existing 

One 

1. Click and select the Invoice worksheet if it isn't already selected.  

2. Click any cell in the BILL TO section. The "On-Sheet Picker" button 

appears. 

3. Click the "On-sheet Picker" button to display the Customers selection 

dialog box, and then double click to select the customer. All customer 

information will be written to the Invoice worksheet, including the 

customer ID.  

4. On the Invoice worksheet, clear the customer ID field, and modify other 

fields as needed.  

5. Click the Save As New Customer button to create a new customer.  

Please move to the Customer Detail section for a detailed explanation of the 

Customer Edit window.  

13.2 Edit Existing Customers 

The tool for editing a customer is the Customer Edit window. Below is a screen 

shot of the Customer Edit window.  
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1) Editing a Customer through the Customers Window 

1. Click and select the Invoice ribbon tab if it isn't already selected.  

2. Click the Customers button to open the Customers window.  

3. On the Customers window, browse to the customer you want to edit, or 

find the customer using the search bar.  

4. Double click the customer record to open the Customer Edit window.  

5. Make changes as you like, and then click the Save button.  

2) Editing a Customer through the Invoice Worksheet 

If the customer is displayed on the current Invoice worksheet, you can also click 

the View Customer Info button to open the Customer Edit window for this 

customer.  

Please move to the Customer Detail section of this chapter for a detailed 

explanation of the Customer Edit window.  

13.3 Customer Detail 

  

See also: Add New Customers - Edit Existing Customers 
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The Customer Edit window provides a number of fields where you may store 

additional data in, if you so desire. The only required field on this window is the 

Name field, which can be either a person's name or a company name. The 

customer ID field is filled in automatically if you do not manually key one in.  

 

Here is a description of the command buttons on the command list bar.  

Button Action 

Save 

After editing a customer's record you need to save your 

changes! Click this button to save your changes to the 

database. 

Delete 

Deleting a customer totally removes the customer 

record from the database. This doesn't affect previously 

created invoices. 

Shipping address 

This button opens a new data list window and displays 

all shipping addresses belonging to the current 

customer. You can use this button to create multiple 

shipping addresses for one customer. When creating 

new invoices, you can use the Select Shipping Address 

icon button (the magnifier icon) near the Ship To label 

to select a shipping address. 
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Category 
This button opens a data list window where you can 

add, edit or delete customer categories.  

Email 

If you have an email client (like Outlook Express), it will 

open and compose a new message to the address 

listed in the Email field. 

New Invoice 

This button will create a new invoice for the current 

customer, filling in all information available 

automatically. 

History Invoice 
This button lists all invoices created for the current 

customer in a data list window.  

Payment 
This button allows you to add a new payment for the 

current customer's pending invoices. 

Statement Creates a new Customer Statement report. 

Refresh 

Reload data from the database. This command is used 

basically in a network environment where multiple 

users open the same database. You can use this button 

to refresh data modified by other uses. 

  

Below is a description of some important fields on the Customer Edit window.  

Field Name Description 

ID 
The ID value uniquely identifies a customer. This value 

is generated automatically if left blank.  

Name 

Required. This is a free form text field indicating the 

name of the customer. This can be a company name, a 

personal name or any combination thereof. 

Category 

The category field helps you organize customers. Click 

the Customer Category button on the Command List bar 

to manage categories.  

Account Balance 
This is the total balance due for all outstanding invoices 

for this particular customer.  

Updated Date 
This field is updated to the current date whenever the 

account balance is changed.  

Status 

Potential values are Active, Inactive and Terminated. Only 

active customers will be displayed when you click the 

Select Customer icon button on the Invoice worksheet. 
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14. Products 

14.1 Add New Products 

1. Click and select the Invoice ribbon tab if it isn't already selected.  

2. Click the Products button on the Invoice ribbon tab. This displays the 

Products data list window.  

 

3. Click the Add button. This displays the New Product window.  

4. Fill in the data fields. Product Description is the only required field.  

5. Click the Save button. If succeeded, the New Product window becomes 

Product Edit window.  
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That's it! You have created a new product! Please move to the Product Detail 

section for a detailed explanation of the Product Edit window.  

14.2 Edit Existing Products 

Below is a screen shot of the Product Edit window. 
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To open it: 

1. Click and select the Invoice ribbon tab if it isn't already selected.  

2. Click the Products button on the Invoice ribbon tab to open the Products 

data list window.  

3. Browse to the product record you want to edit, or find it using the search 

bar.  

4. Double click the product record to open the Product Edit window.  

5. Make changes as needed.  

6. Click the Save button to save changes.  

Please move to the Product Detail section of this chapter for a detailed 

explanation of the Product Edit window.  
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14.3 Product Detail 

  

See also: Add New Products - Edit Existing Products 

  

The Product Edit window provides a number of fields that you may optionally 

store data in. The only required field on this window is the Description field. 

However, you will want to fill in other fields like price, and stock if applicable.  

 

First, let us look at the Command List bar.  
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Button Action 

Save 
Whenever you edit or add a product you want to be 

sure to save your changes! 

Delete 

Deleting a product totally removes the product record 

from the database. This does not affect previously 

created invoices. 

Sync Cost 

By default, the product cost of an invoice item is set to 

the cost value of that product when you create an 

invoice, and the total cost of the invoice is calculated 

based on that cost. However, you can use this button to 

update all invoice items related to the product and to 

set their cost value to the product's current cost.  

Category 
This button displays the Product Category window where 

you can add, edit, and delete product categories. 

Report 
This button displays the Reports window where you can 

create new reports.  

Refresh 

Reload data from the database. This command is used 

basically in a network environment where multiple 

users open the same database. You can use this button 

to refresh data modified by other uses. 

  

Below is a description of some important fields on the Product Edit window.  

Field Name Description 

Category 

The category field helps you organize products. Click 

the Product Category button on the Command List bar 

to manage categories. 

Product ID 
The ID value uniquely identifies a product. This value is 

generated automatically if left blank. 

Description 
The product's description is the only required 

information you must enter. It is a free-form text field. 

Status 

Potential values are Active and Inactive. Only active 

products will be displayed when you click the Select 

Product icon button on the Invoice worksheet. 

Is a service 
Check this box If you do not maintain a physical 

inventory for the product.  
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15. Invoices 

15.1 Create New Invoices 

For a quick start tutorial, click here. 

There are several ways to start creating an invoice. Each method will eventually 

lead you to the same interface - the Invoice worksheet. For example, if you click 

the New Invoice button on the Customer Edit window, the system clears the 

Invoice worksheet and fills it with the information about that customer. This is the 

same as clicking the Clear & New button to clear the Invoice worksheet, and then 

clicking the Select Customer on-sheet picker button to select the customer. 

There are 3 essential steps to create an invoice: 

1. Clear the Invoice worksheet. This can be done by clicking the Clear & New 

button.  

2. Fill in the necessary information, including customer information and 

product information.  

3. Save the invoice to the database by clicking the Save Invoice button.  

For additional information, please refer to the Invoice Detail section of this 

chapter for more information.  

15.2 Edit Existing Invoices 

An invoice can be edited ONLY if its status is pending. If the invoice status is void 

or paid, then only the Notes field is data input capable for editing.  

There are two tools to edit an invoice. The first is the Invoice worksheet, and the 

second is the Invoice Edit window. Regardless of which one you choose, you 

always need to find the specific invoice in the first place, if it is not currently 

displayed or shown.  

To find an invoice: 

1. Click the Invoices button on the Invoice ribbon tab to open the Invoices 

window.  
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2. Browse to the invoice you want to edit, or find the invoice using the search 

bar.  

3. If you want to edit it in Excel, click the Edit in Excel button on the toolbar. If 

you want to edit it using the Invoice Edit window, simply double click it.  

You will find additional information in the Invoice Detail section of this chapter.  

Note: If you know the ID (invoice #) of the invoice, you can also type the ID into 

the Invoice # cell in the Invoice worksheet and press Enter to retrieve it from the 

backend database. This feature is called In-Cell Lookup.  

15.3 Invoice Detail 

  

See also: Create New Invoices - Edit Existing Invoices 

  

Both the Invoice worksheet and the Invoice Edit window can be used to edit an 

invoice, although there are some significant differences between the two.  
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Invoice 

worksheet 

Invoice Edit 

window 

Create new invoices Yes No 

Add invoice items Yes No 

Delete invoice items Yes Yes 

Delete or void payment No Yes 

Void invoices No Yes 

Delete invoices No Yes 

Payment History No Yes 

The Invoice worksheet 

Here is a screen shot of the default Invoice worksheet. You can also download 

customized invoice templates from Invoicing Templates. 

 

It's easy to get started with the Invoice worksheet because it is based on the What 

You See Is What You Get (or WYSIWYG) paradigm. However, to be effective, there 

are still some important points you need to know. 

▪ The Clear & New button clears the Invoice worksheet. After clearing, the 

Invoice Date and Shipping Date field automatically revert to the current 

http://www.invoicingtemplate.com/
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date. The Tax Rate, Sales Rep. Name, Ship Via, Terms are also set to their 

default values respectively. You can set these default values by clicking the 

Settings button on the Invoice worksheet.  

▪ The Invoice worksheet is protected by default to avoid accidentally 

corrupting formulas. If you want to alter the protected contents such as 

the company name, logo and certain text labels, you can unprotect it by 

clicking Review tab -> Changes group -> Unprotect Sheet if you are running 

Excel 2007/2010/2013. When you finish customizing the worksheet, it is 

strongly recommended that you return the worksheet to protected status 

to avoid accidental corruption of formulas. 

▪ By default, the maximum number of invoice line items is 12. These lines 

must be filled, one by one, with NO blank rows between them. For 

example, if you have three product line items, then they must be keyed or 

entered into rows 1, 2, and 3. If you filled them into rows 1, 2, and 4, then 

only row 1 and 2 will be saved to the database. Because line 3 was skipped 

or left blank, then Row 4 will be discarded if you choose to disable the 

"Allow incomplete lines" feature on the Settings window.  

An item is treated as blank if ANY of the following fields are empty or zero: 

Product ID, Product Description, and Line Total.  

For an in-depth look at the invoice template, see Customizing the Invoice Template.  

The Invoice Edit window 

The Invoice Edit window allows you to edit most fields of an invoice, except the 

calculated fields, tax rate fields, shipping costs, and invoice items.  

Here is a screen shot of the Invoice Edit Window. 
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Button Action 

Save Saves the modified data to the database. 

Edit in Excel Displays the current invoice in Excel. 

Void 

Deletes the invoice from the Sales Record 

but keeps a copy in the database for 

reference. 

Print 
Displays the invoice in the Invoice worksheet 

and prints it, using default print options. 

Email 

Displays the invoice in Excel, extracts the 

Invoice worksheet as a new workbook, and 

creates a new email message to send the 

workbook to selected e-mail address. 

Delete 

Deletes the invoice record from the 

database. This will delete all payments and 

place all products back into stock (where 

applicable).  

Refresh 

Reload data from the database. This 

command is basically used in a network 

environment where multiple users open the 

same database. You can use this button to 
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update or refresh data modified by other 

uses. 

Unlike the Invoice worksheet, the Invoice Edit window shows you all the payments 

on the Payments tab, where you can add new payments, remove or edit existing 

payments. To add a new payment, click the Add Payment button. To remove or 

edit an existing payment, double click the payment record to open the Payment 

Edit window.  

16. Payments 

16.1 Add New Payments 

There are 3 ways to add new payments, though all of them lead you to a similar 

New Payment window. 

Using the Payment button on the Invoice ribbon tab 

If the invoice for which you want to post a payment is displayed on the Invoice 

worksheet, you can use the Payment button on the ribbon tab to display the New 

Payment window. Enter the payment information, and click the Save button to 

save the payment.  

Tip: If you check the Prompt for new payment option on the Settings window, the 

New Payment window will be displayed automatically whenever a new invoice is 

saved to the database.  

Using the Customer Edit window 

1. Click and select the Invoice worksheet if it isn't already selected.  

2. Click the Customers button on the Invoice ribbon tab to open the Customers 

data list window.  
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3. Browse to the customer. You can use the search bar to find the customer 

quickly.  

4. Double click the customer record in the data list to open the Customer Edit 

window.  

 

5. Click the Payment button to display the Customer Payment window, where 

you can double click to select a pending invoice. This will display the New 

Payment window for the invoice.  

6. On the New Payment window, make changes if needed.  
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7. Click the Save button on the New Payment window to save the new 

payment to the database.  

Using the Invoice Edit Window  

1. Click and select the Invoice worksheet if it isn't already selected.  

2. Click the Invoices button on the Invoice worksheet to open the Invoices 

data list window.  

 

3. Browse to the invoice for which you want to add a payment. You can use 

the search bar to find the invoice quickly.  

4. Double click the invoice record in the data list to open the Invoice Edit 

window.  

5. Click and active the Payments tab, where you can find a list of payments 

you post for the current invoice.  
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6. Click the Add payment button to display the New Payment window.  

7. On the New Payment window, make changes if needed.  

8. Click the Save button on the New Payment window to save the new 

payment to database.  

That's it! You have created a new payment! Please move to the Payment Detail 

section for a detailed explanation of the Payment Edit window.  

16.2 Edit Existing Payments 

A payment is not editable if the invoice has been voided or paid. It is editable 

only if the invoice is still pending. For a voided payment, only its Notes field is 

editable. Follow these steps to edit a payment:  

1. Click and select the Invoice worksheet if it isn't already selected.  

2. Click the Invoices button on the Invoice worksheet to open the Invoices 

data list window.  
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3. Browse to the invoice for which you want to add/Edit a payment. You can 

use the search bar to find the invoice quickly.  

4. Double click the invoice record in the data list to open the Invoice Edit 

window.  
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5. Click and activate the Payments tab. This will display a list of payments 

which have been posted for the current invoice.  

6. Double click the payment you want to edit.  

 

7. Make changes as needed, then click the Save button to save the payment.  

The Payment Detail section contains an even more detailed explanation of the 

Payment Edit window.  

16.3 Payment Detail 

  

See also: Add New Payments - Edit Existing Payments 

  

The Payment Edit window provides a number of fields that you may optionally fill 

out. The only required field on this window is the Total Payment field.  
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Here we have a look at the commands on the toolbar.  

Button Action 

Save 

After editing the payment, you need to 

click this button to save the changes to the 

database.  

Delete 

Deleting a payment will remove the 

payment record completely from the 

database.  

Void Payment 

Voiding a payment will mark the payment 

voided and change the status of the 

invoice back to pending. Unlike deleting a 

payment, voiding a payment will keep the 

payment record in the database. 

Refresh 

Reload data from the database. This 

command is used basically in a network 

environment where multiple users open the 

same database. You can use this button to 

refresh data modified by other uses. 
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17. Applying One Payment to Multiple 

Invoices - Batch Payment 

The easiest way to apply one payment to multiple invoices (i.e. batch payment) is 

to use the "Credit" feature of Invoice Manager. 

1. Open the customer list by clicking the "Customers" button on the ribbon 

tab. 

2. Find the customer who sends the payment. If you have lots of customers, 

use the search bar to locate the customer easily. 

3. Double-click to open the "Customer Edit" window. 

4. Click "History Invoices". To show only the outstanding invoices, apply a 

filter to show invoices whose balance due are greater than 0 (zero).  

 

5. Double-click an invoice. 

6. Go to the "Payments" tab. 

7. Click "Add" 

8. Enter the whole paid amount and click "Save". The overpaid amount will 

be saved as credit of the customer. Close the "New Payment" window. 

9. Now you're returned to the list of invoices. Double-click another 

outstanding invoice. 

10. Go to the "Payments" tab. 
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11. Click "Apply Credit". 

12. Enter the credit amount to apply. Click "OK" to close the "Apply Credit" 

window. 

13. Close the "Invoice Edit" window to return to the list of invoices. 

14. If there are still outstanding invoices and available credit, you can continue 

the process to apply all the available credit. 

18. Reports 

Contents 

Generating and printing reports 

Setting visible columns 

Extracting report 

Generating and printing reports 

The tool to generate reports is the Reports window. There are several ways to 

open this window:  

▪ Click the Reports button on the Invoice ribbon tab.  

▪ Click the New Report button on the task pane which is shown when any 

report worksheet is active. 

▪ On some data list windows and data edit windows, there are also 

command buttons to open the Reports window. For example, On the 

Customer Edit window, you can find a Statement button.  

The only difference between them is how the window is initialized. For example, if 

you open the Reports window by clicking the New Report button on the Sales 

Report worksheet, the initial tab will be Sales Report.  

Below is a screen shot of the Reports window. 
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The Reports window contains six tabs, corresponding to five report worksheets in 

the invoice workbook. Consult the description on the window to learn how to set 

report options. After setting the options, click the Generate Report button to create 

a report.  

If successful, the generated report will be displayed on the corresponding 

worksheet. 

Note: As you can see, the report worksheets are used primarily as a temporary 

work area, but not the place to store your report data. Each time you try to 

generate a new report, the previous report data will be overwritten.  

To print a report, click the Print button on the report worksheet. This will print out 

the report worksheet with the default print options and default printer. If you 

want to customize your print work, click Page Layout tab in Excel 2007/2010/2013.  

Setting visible columns 

Click the Columns button on the task pane (shown when any report worksheet is 

active) to display the Columns window, which lists all available columns on the 

current report worksheet, and allows you to set the visible columns for that 

report.  
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For example, below is the Columns window displayed by clicking the Columns 

button on the Sales Report worksheet.  

 

To hide a column, clear the checkbox before the column name. There is ONE 

exception: The first column on each report worksheet is the key column to sort 

and group the report data. DO NOT hide or delete the first column of each 

report. 

In general, the number of available columns is sufficient. Most of the time, you 

will want to hide some of the columns. This is not a problem unless you want to 

send the report to someone else. You must carefully review those hidden 

columns when sending out report worksheets. Be very careful that these 

hidden columns do NOT provide information that you do NOT wish to share 

with others. The Settings window provides a Remove Hidden Rows and Columns 

after Extracting Report option to help you remove those hidden columns 

automatically. If you need to send out an extracted report, DO NOT clear that 

checkbox. 
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Extracting report 

To extract a report, click the Extract button on the corresponding report 

worksheet. 

Extracting a report will copy the report worksheet and create a new workbook. 

The extracted report is a free copy, that is, it is outside the Invoice Manager for 

Excel and you can do anything with it. For example, you can email it out, add or 

delete data, or simply do some formatting.  

  

  

  

  

  

19. Common Tasks 

19.1 Search Bar 

What is it 

The search bar on the Customers, Products, and Invoices data list windows consist 

of two list box controls, one text box control, and several command buttons. To 

search all records meeting your specific criterion, follow the steps below.  

How to use 

For Example: Let's say you open the Customers window and want to find all 

customers whose name contains Uniform:  

1. Select a search field from the first list box. In this example, you select 

Name from the first list box.  
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2. Select a search operator from the second list box. The search operators 

you can select vary according to the type of the field you selected in the 

first list box. For text field, the operators you can use are: Equals, Contains, 

Starts With, Ends With, Is Less Than, Is Greater Than. For a numeric field, the 

allowed operators are: Equals, Is Less Than, and Is Greater Than. In this 

demonstration example, you select Contains from the second list box.  

 

3. Enter the search key value in the text box. In this example, you enter 

uniform.  

 

4. Click the Search button. The data list will display all records meeting your 

criterion.  

5. To display all records again (i.e. remove the criterion), click the Reset 

button.  

6. If you click the Set as Default button, the current search options in the field 

name box and search operator box will be saved. For example, in the 

Products data list window, if you select Product Name from the search field 

box, and select Contains from the search operator box, and then click the 

Save as Default button, these options are saved. After that, each time you 

open the Products window or Product-Selection window, these options are 

restored.  
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19.2 Data List Window 

Introduction 

Invoice Manager for Excel uses data list windows in many cases to show you a list 

of records loaded from the backend database, including the Customers window, 

the Products window, the Invoices window, and those windows that can be 

opened by clicking the Edit button on the Misc Data tab of the Settings window. 

Tip: For information on using the search bar, see Search Bar. 

Tip: Data list windows use form property files for storing the sizes and column 

widths. To reset all these to defaults refer to Form Properties File. 

 

How to use 

Here are some tips to help you work with data list windows easily and effectively. 

▪ Resize data list windows and grid columns  

https://www.invoicingtemplate.com/software.html
https://www.invoicingtemplate.com/form-properties-file.html
https://www.invoicingtemplate.com/images-doc/example-of-data-list.png
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You can resize the width and height of a data list window, as well as the 

widths of grid columns, to best fit your needs. All the new properties are 

saved automatically when you close a data list window, and restored 

automatically when you re-open the window. 

▪ Export the data list to an Excel file  

All the data list windows provide an Export command, which can be found 

on the toolbar. Click this command to export the content of the current 

data list to an Excel file. Using this feature, you can easily get a list of 

products, customers or invoices.  

▪ Sort by any column  

Click a column header to sort by that column. Double click it again to 

change its sort order - ascending or descending.  

▪ Display or hide any column  

If the data list window provides the Columns command on the toolbar, 

click it to open the Columns dialog box.  

▪ Move columns  

To move a column in the data list area, first click the column header to 

select it, and then push your mouse button on the column header and 

drag it to its new location.  

All the customizable properties of the data list windows - the height and width of 

a window, column widths, visible column names and order, sort criterion, etc., are 

stored and will be restored next time you open it.  

19.3 Share Database 

Introduction 

Sharing an Access database could be done between two or more templates, such 

as an invoice template and a packing list template, or between two or more 

computers. This feature is supported in the "Net" and "Enterprise" edition. Refer 

to Differences between editions for more information. 

https://www.invoicingtemplate.com/software.html#editions
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By sharing database two or more users could work on same database file. 

NOTE: Each computer requires its own license key/registration code. 

Sharing Access database file requires the computers connected on a LAN (locally 

area network). If you need to share data via the Internet, choose the "Enterprise" 

edition and migrate the Access database file to online SQL Server. See Online 

Invoicing Sample for a practical example. 

Steps 

This simple tutorial goes through the steps for sharing database(s) between two 

computers. 

Let's say we have two computers. Computer LIVINGROOM running Windows 8 

will host the shared database file, and another computer running Windows 7 will 

connect to the database hosted on LIVINGROOM. You can easily find similar 

options on Windows 10. These two computers are locally networked -- i.e. 

connected via a LAN.  

▪ Create a folder named DB on LIVINGROOM.  

▪ Right-click the DB folder and select Properties. 

▪ Switch to the Sharing tab.  

▪ Click Share. 

▪ On the 'Choose people to share with' dialog box, add the Windows user 

name with whom you want to share the database file. Make sure the 

'Permission Level' is set to 'Read/Write'.  

https://www.invoicingtemplate.com/online-invoicing-sample.html
https://www.invoicingtemplate.com/online-invoicing-sample.html
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▪ Click Share.  

▪ Store the database file in the DB folder, or create a new database file in 

the DB folder.  

▪ On the Windows 7 machine, open your invoice template as usual. 

▪ Click Settings. Go to Database tab. 

▪ Click Open database under the Access database tab. 

▪ Browse to and select database file in the shared DB folder on 

LIVINGROOM.  

https://www.invoicingtemplate.com/images-doc/share-database-pemission-level.png
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Once the template successfully connects to the shared database, the 

Current Database field on the Invoice worksheet will show the name of the 

database that is currently connected with. 

▪ Save the template once. This insures the template will connect to the 

specified database automatically next time you open it. 

Tip: If you see the error "An error occured while submitting data. Operation must 

use an updateable query.": 

▪ Make sure the database file is stored in a folder where the connected PC 

(its Windows account) has full access privilege. 

▪ You need at least the "Net" edition. 

▪ Each computer requires its own license key - i.e. If you I have 3 computers, 

you need 3 licenses, one for each. 

19.4 Migrate Access Database to SQL 

Server 

Step 1 - Create SQL Database (Optional) 

Note: Visit Online Invoicing Sample for our running sample of online SQL Server. 

https://www.invoicingtemplate.com/online-invoicing-sample.html
https://www.invoicingtemplate.com/images-doc/share-database-choose-shared-db.png
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If you run SQL Server on local network, you might have the permission to create 

database using tools like SQL Server Management Studio. Invoice Manager for 

Excel is also able to create database from the Settings window / Database tab. 

If you run SQL Server on the Internet and your hosting provider does not support 

creating database remotely, you can create database from your hosting control 

panel, such as Plesk control panel. For example, if you have a shared Windows 

hosting plan with Godaddy, you should create new database by using their Plesk 

control panel. Be sure to write down the database server name, database name, 

database login user name and password. 

 

Step 2 - Test Connection with SQL Server Management 

Studio 

Download and install Microsoft SQL Server Management Studio 

(https://msdn.microsoft.com/en-us/library/mt238290.aspx). Connect to the 

remote database with the server name, database name, user (login) name, and 

password. 

https://msdn.microsoft.com/en-us/library/mt238290.aspx
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Step 3 - Connect SQL Server Using Invoice Manager 

for Excel 

Now start Invoice Manager for Excel. Click Settings and go to the Database tab, 

and then choose "SQL Server Database" as the database type. 
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On the above figure, Invoice Manager for Excel is connecting with an Access 

database (that is why the "Access Database" tab is marked as "Active"). To 

connect a SQL Server on the Internet, on the "SQL Server" tab, you should fill in 

the fields "Server Name", "Authentication Mode" (This is usually "SQL Server 

Authentication" for SQL Servers on the Internet; and for the SQL Servers running 

on the local domain, it is usually "Windows Authentication"). See Authentication 

in SQL Server for more information. 

In case of "SQL Server authentication", you need to also fill in "Login name" and 

"Password". "Database name" is also a required field. 

If this database (as specified in the "Database name" box) is not created on the 

server side yet, check "Create new database". Note that if your SQL Server is 

running on the Internet using a shared web site hosting account, your SQL Server 

account may not have the permission to create database this way. In this case, 

the database should be created using the web hosting control panel, such as 

Plesk. 

If your database is created from the Web hosting control panel, it is an empty 

database that does not contains the required tables to run Invoice Manager for 

https://docs.microsoft.com/en-us/dotnet/framework/data/adonet/sql/authentication-in-sql-server
https://docs.microsoft.com/en-us/dotnet/framework/data/adonet/sql/authentication-in-sql-server
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Excel. Click "Connect to SQL Server" button, Invoice Manager for Excel will create 

the tables automatically. 

If Invoice Manager for Excel connects with the specified SQL Server database 

successfully, it saves the connection in the invoice template. To make this the 

default connection (so that the program restores the connection next time you 

start Invoice Manager for Excel), you should save the template by clicking the 

"Save" button on Excel quick access toolbar. 

Step 4 - Verify and create custom fields 

If your template is connecting with an Access database, and you create your SQL 

Server tables with the Access database connected, then all custom fields defined 

in the Access database tables are created on the SQL Server database too. 

However there are situations where the SQL Server tables contain only standard 

fields only. 

To make the later importing procedure smoothly, it's better to verify if the 

custom fields are created identically as in the original database. 

1. Open your invoice template as usual. 

2. Make sure it is connecting to your "old" database -- i.e. the database that 

contains the data to be exported. 

3. Click "Customers" on the "Invoice" ribbon tab, and then "Custom fields". 

4. From the "Database table" list, choose "Customer". 

5. Write down "Name" and "Type" of each custom field. 

6. Repeat step 5 and 6 for other tables -- "Shipping Address", "Product", 

"Invoice Header" and "Invoice Body". 

7. Now connect to your new SQL Server. 

8. Click "Customers" on the "Invoice" ribbon. 

9. Click "Custom Fields". 

10. Select a table from the "Database table" list. 

11. Click "Add field" to add a custom field. Make sure the "Name" and "Type" 

match exactly what you have write down. 

12. Repeat step 10 and 11 to create all the required custom fields for other 

tables. 

Step 5 - Import Existing Invoice Manager for Excel 

Data 
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You can use "SQL Server Import and Export Wizard" to import existing data, from 

either local Access database or local SQL Server database, to an online remote 

SQL Server database. 

Before begin, first make sure you are able to connect to the remote SQL Server 

database from Invoice Manager for Excel, as detailed above. This also makes sure 

that the database contains all the tables required by Invoice Manager for Excel, 

and all the fields in the database are defined exactly as required by Invoice 

Manager for Excel. 

SQL Server Import and Export Wizard could be start from Windows 10 search / 

command box or from within SQL Server Management Studio. Let's say you have 

started SQL Server Management Studio. From the "Object Explorer" located on 

the left side, expand "Databases" node and then right-click any database (not 

necessary the destination database). Right-click the database name and choose 

"Task" and then "Import Data". This starts "SQL Server Import and Export Wizard". 

Click "Next" on the welcome screen to go to the "Choose a Data Source - Select 

the source from which to copy data" page, as shown on the figure below. 
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From the "Data source" drop down list, choose the type of your database. If your 

source data is in an Access database, then choose "Microsoft Access (Microsoft 

Access Database Engine)", the wizard then shows options that allow you to 

browse to and specify the Access database file used by Invoice Manager for Excel. 

If your local database is a SQL Server database, choose "Microsoft OLE DB 

Provider for SQL Server" or "SQL Server Native Client". The wizard shows options 

to let you specify the login information for the SQL Server. 

Click Next to go to the "Choose a Destination - Specify where to copy data to" 

screen, as shown below. 
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Assuming we are going to copy data to a remote SQL Server database, from the 

"Destination" drop down list choose "Microsoft OLE DB Provider for SQL Server". 

And then specify the server name (or address), authentication mode, and in case 

of "SQL Server authentication", you'll also need to provide "User name" and 

"Password". Click "Refresh" to connect to the SQL Server and have the "Database" 

drop down list populated. You can then choose your destination database, or fill 

in the database manually. 

Click "Next" to go to the "Specify Table Copy or Query" page. Since we want to 

import data from a local database to a remote SQL Server database, choose 

"Copy data from one or more tables or views". 
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Click "Next" to go to the "Select Source Tables and Views" screen. Check the box 

before each table name from where you want to import data. 

Note that don't import data from the "InvOption" table and "InvCost" View. 
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Once a table is selected, click "Editing Mappings" to verify column mappings. 

Select "Append rows to the destination table" if you are adding additional data to 

the destination table; or select "Delete rows in the destination table" if you want 

to empty the destination table before adding data to it. Also make sure each 

column in the source table is mapped correctly to the column in the destination 

table. Check the "Enable identity insert" option. 
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After verifying the mappings, click "Next" to start importing data. 

Delete Existing Objects 

If some objects were already created during the previous unsuccessful importing 

process, it is necessary to delete all those objects before running the new 

importing procedure. To delete these objects: 

1. Start SQL Server Management Studio. 

2. Connect to your SQL Server. 

3. From the left pane, expand the "Database" node. 

4. Find and expand your database name. 

5. Delete all objects under <database name>\Tables and <database 

name>\Views that has the "dbo" prefix in their names. See figure below.  
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6. Once done, start to import your database. 

19.5 Email Customer Statement and 

Aging Report 

Starting with version 8.11, you can easily email customer statement and account 

aging report. 

Requirements: 

▪ The customer's email address field has been correctly filled. 

▪ The email settings are correctly filled. To set the options, click the 

"Settings" button on the "Invoice" ribbon tab, and then click the 

"Extract/Email" tab. 
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To email reports to customer: 

▪ Open the "Reports" window by clicking the "Reports" button on the 

"Invoice" ribbon, or click the "New Report" button on one of the report 

worksheets. 

▪ Make sure the "Customer Statement" tab or the "Aging" tab is active. 

▪ Check "Email PDF report to customer" option is checked. 

▪ Select the customers that you want to send reports to. 

▪ Click "Generate Report". 

▪ If there are multiple reports generated / sent, a log file will be shown once 

the operation is finished. 

19.6 Add-ins Appear in Excel 

Add-ins appear in Excel 

Once Invoice Manager for Excel is successfully installed, it appears as add-in 

programs of Excel. 
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You can verify the installation details inside Excel. Note that this is not required 

for general users. But if you are interested in the technique details of Invoice 

Manager for Excel, here is how to find the add-in programs inside Excel. 

First make sure Excel "Developer" ribbon tab is visible. If it is not, then right-click 

an empty area on any ribbon tab and choose "Customize the ribbon". On the 

"Excel Options" dialog box, make sure "Developer" is checked to show the 

"Developer" ribbon tab. You can also open this dialog box by clicking Excel menu 

"File" / "Options". 

 
On the same "Excel Options" dialog box, click "Add-ins" on the left pane, you'll 

see 4 entries listed that are all belong to Invoice Manager for Excel. 
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Now close the "Excel Options" dialog box. Go to the "Developer" ribbon tab. If 

you are running Excel 2016 or 2019, there are 3 entries in the "Add-ins" group: 

Add-ins, Excel add-ins, COM add-ins. Click "Excel add-ins", it shows the loader 

program of Invoice Manager: 
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If you click "COM add-ins", it shows 3 entries of Invoice Manager that are 

implemented as COM add-in. 

 

20. Customizing Invoice Template  

Contents 

Customizing invoicing templates means creating your own templates that can 

interact with Invoice Manager for Excel and connect to databases to store and 
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retrieve data. All templates here on InvoicingTemplate.com are created based on 

these rules.  

Please read this document carefully before customizing your template. 

▪ Create new invoice templates 

▪ Design mode 

▪ Protection 

▪ Locking/unlocking Cells 

▪ Gridlines and row/column headers 

▪ Names 

▪ ActiveX controls 

▪ Shapes 

▪ Printing 

▪ Moving cells/controls 

▪ Extracting ActiveX controls and drawing objects 

▪ Resizing columns and rows 

▪ Color schema and palette 

▪ Currency symbols 

▪ Inserting a new column 

Create New Invoice Templates 
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An invoice template uses a number of hidden properties and cells to identify 

itself as a valid invoice template so that the Invoice Manager for Excel can and 

will interact with it.  

Because of this, generally it is not recommended to create a template or 

workbook from scratch using Microsoft Excel. It's better to create an invoice 

template based on an existing valid invoice template. To do this, copy an existing 

invoice template using your Windows Explorer, and customize that copy to create 

your own invoice workbook.  

However if you still want to integrate your existing template with Invoice 

Manager for Excel, or create a new format from scratch, the steps are detailed 

with the sample at c4056 Simple Sample - Building & Remodeling Invoice. 

Design Mode 

An invoice template has two states: design mode and running mode. In design 

mode, Invoice Manager for Excel stops interacting with the invoice template, so 

that you can move, add, or delete controls or cells.  

To switch to design mode, click the Design Mode button on the Invoice ribbon tab. 

Click this button again to exit design mode.  

Protection 

The protection of the "Invoice" worksheet prevents accidental modifications to 

layouts, formulas and other form designs. If you have Invoice Manager for Excel 

installed, it could even display a warning message when you close a template 

without protecting the worksheet. However for the purpose of this customizing a 

template, we should firstly unprotect the worksheet. 

Tip : If you have Invoice Manager for Excel installed, the "Design Mode" button 

unprotects an sheet automatically.  

By default, the Invoice worksheet is protected. You need to unprotect it for most 

of the customization work. To unprotect the worksheet, in Excel 2007/2010/2013 

click the Unprotect Sheet button in the Changes group of the Review tab.  

It is strongly recommended that you protect the worksheet again after your 

customization. To protect a sheet, just click the same button again.  

https://www.invoicingtemplate.com/createinvoicetemplate.html
https://www.invoicingtemplate.com/createinvoicetemplate.html
https://www.invoicingtemplate.com/simple-sample-template-building-remodeling.html
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Locking/Unlocking Cells 

If a worksheet is protected, locked cells and those cells that contain formulas are 

not manually editable. To lock or unlock a cell:  

1. Unprotect the worksheet if it is already protected. 

2. Right-click the cell, choose Format Cells. 

3. Click the Protection tab. 

4. Check or uncheck the Locked option. 

Gridlines and Row/Column Headers 

When customizing a workbook, it is very helpful to display gridlines and 

row/column headers. To show gridlines and row/column headers in Excel 2003:  

1. Click and activate the worksheet you want to display gridlines and 

row/column headers for.  

2. On the Tools menu, click Options, and then click the View tab.  

3. Under Window options, check the Gridlines and Row & Column Headers 

check boxes.  

After your customization, go back to the Tools menu, Options, View tab. Under 

Window options, REMOVE the checks you previously placed by the two check 

boxes to hide gridlines and row/column headers. This will restore the appearance 

of your workbook.  

To show/hide gridlines and row/column headers in Excel 2007/2010/2013: 

1. Click and activate the worksheet you want to display gridlines and 

row/column headers for.  

2. Go to the View tab of the Ribbon.  

3. Click Show/Hide, and then check or uncheck the Gridlines and Headings 

options.  

Names 

All objects in an invoice workbook, including ActiveX controls, drawing objects 

and cells, are identified by names.  
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To distinguish from other names, all names used by Invoice Manager for Excel are 

prefixed with okn (Office-Kit.com's Name).  

Names defined this way by defalt are available to any sheet. For example, if the 

name oknID refers to the range A20:A30 on the first worksheet in a workbook, 

you can use the name oknID on any other sheet in the same workbook to refer to 

range A20:A30 on the first worksheet.  

To name a drawing object or cell:  

1. Click and select the cell or drawing object.  

2. Click the Name box located at the left end of the formula bar.  

 

3. Type the name in the Name box.  

4. Press ENTER.  

To name an ActiveX control object:  

1. Switch your workbook to design mode.  

2. Right click the ActiveX object.  

3. Select Properties from the menu.  

4. In the Properties window, enter the name in the Name field.  

Note that Excel does not allow you to reuse an existing name in this way. For 

example, if a cell has already been named "oknTaxType", and you click and select 

an empty cell then enter the name "oknType" into the name box, Excel activates 

the cell with the name "oknTaxType", instead of naming the empty cell 

"oknTaxType". 

To name a new (empty) cell with an existing name, you have to firstly delete the 

exiting cell name, and then use this name to name the new cell. To delete an 

existing cell name, in Excel 2003 click Excel menu Insert > Name > Define to open 

the "Define Name" dialog box; in Excel 2007, 2010, 2013 and 2016, the Name 
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Manager can be launched by going to the "Formulas" ribbon tab, "Defined 

Names" group. 

 

ActiveX Controls 

Note: Starting from Invoice Manager for Excel version 5, all on-sheet buttons are 

created as shape objects. Don't use ActiveX objects unless you're using Invoice 

Manager for Excel prior to version 5. 

Microsoft Excel has two types of controls. ActiveX controls and form controls. 

Forms controls are compatible with earlier versions of Excel, beginning with Excel 

version 5.0, and can be used on XLM macro sheets.  

To add an ActiveX control:  

1. Switch your workbook to design mode.  

2. In Excel 2007 - 2013, go to the Developer tab, click Insert in the Controls 

group, and then choose the ActiveX control you want to add.  

3. Click on the worksheet at the location where you want to place the 

control.  

4. Drag the control to the size you want.  

5. Right click the control and select Properties from the menu.  

6. Enter the name, caption, and other properties if needed.  

7. Close the Properties window.  
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8. To quit design mode and enable the ActiveX control, click Exit Design Mode 

on the Control Toolbox toolbar if you are running Excel 2000 - 2003; or 

click the Design Mode button in the Controls group of the Developer tab if 

you are running Excel 2007/2010.  

Shapes 

If you like the invoices and receipts created by InvoicingTemplate.com, you may 

find that some Excel shapes and Smart Art objects easily dress up a business 

document.  

Simple Sample - Using Shape Object provides a basic example on using shapes. 

Here is how to use Excel shapes or SmartArt objects in your own template. In 

Microsoft Excel, you can add shapes, such as boxes, circles, and arrows, to your 

documents, email messages, slide shows, and spreadsheets. To add a shape, click 

Insert, click Shapes, select a shape, and then click and drag to draw the shape. 

After you add one or more shapes, you can add text, bullets, numbering, and 

Quick Styles to them. To add a shape: 

1. Open your Excel template. Unprotect spreadsheet. 

2. On the Insert tab, in the Illustrations group, click Shapes. 

3. Click the shape you want, click anywhere in the workbook, and then drag 

to place the shape. 

4. To create a perfect square or circle (or constrain the dimensions of other 

shapes), press and hold Shift while you drag. 

Note the additional shapes are removed when executing the "Extract/Email" 

command. To prevent this, name the object with "oknWidget" prefix. 

Printing 

The PRINT_AREA Name 

If a worksheet has defined a PRINT_AREA name and it refers to a range of cells, 

Excel will print the specified area instead of the whole sheet when you click the 

Print command on the Excel menu. (See our template gallery at printable invoice 

template)  

https://www.invoicingtemplate.com/simple-sample-invoice-shape-object.html
https://www.invoicingtemplate.com/printable.html
https://www.invoicingtemplate.com/printable.html
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In the invoice workbook, each worksheet contains a PRINT_AREA name. You can 

view what the name refers to by selecting PRINT_AREA from the Name box at the 

left end of the formula bar. If you want to redefine the PRINT_AREA name, follow 

the steps below:  

1. Select the area you want to print.  

2. In Excel 2007/2010/2013, switch to the Page Layout tab, click Print Area in 

the Page Setup group, and then choose Set Print Area.  

Printing ActiveX Objects and Drawing Objects 

By default, all objects added to a worksheet are printable. You may want to 

exclude some of them from printing, such as the Customer Selection button on 

the Invoice worksheet (seen in the default invoice template shipped with Invoice 

Manager for Excel version 3 and earlier versions).  

To exclude a Drawing Object from printing in Excel 2007/2010/2013: 

1. Right click the drawing object, select Size and Properties....  

2. Go to the Properties tab.  

3. Uncheck the Print Object option.  

To exclude an ActiveX control from printing:  

1. Switch the workbook to design mode.  

2. Right click the ActiveX control, and select Properties from the menu.  

3. Scroll down the properties list and find the PrintObject property.  

4. Change the PrintObject property to False.  

Moving Cells/Controls 

Since all the cells/fields and controls are identified by names, you can easily 

redesign the layout by moving cells/fields/controls. For example, if you don t́ 

want to show the PAID, TOTAL DUE cells/fields on your printed invoice, you can 

move them out of the Print_Area:  

1. Unprotect the Invoice worksheet. 

2. Drag your mouse to select all the cells/fields you want to move. 

3. Push your mouse key on the border of the selected area; drag it to the 

new location.  

4. Once finished, protect the Invoice worksheet.  
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5. Save the template. 

To move a control: 

1. Unprotect the Invoice worksheet. 

2. Switch to design mode. 

3. Click and drag the control to the new location you like. 

4. Once finished, exit design mode. 

5. Protect the Invoice worksheet. 

6. Save the template. 

Extracting ActiveX Controls and Drawing Objects 

To make the extracted worksheet as clean as possible, all ActiveX controls and 

drawing objects will be removed from the extracted worksheet. If you want to 

keep an ActiveX control or a drawing object, add a prefix oknUser_ or oknWidget_ 

to its name. For example, a logo image could be named oknWidget_logo, 

instructing Invoice Manager for Excel to keep the logo image on the extracted 

document.  

Resizing columns and rows 

Resizing columns is easy in Microsoft Excel. For example, let's say you want to 

change the width of column A.  

▪ Make sure the template is unprotected. 

▪ Place the mouse pointer on the line between columns A and B in the 

column header. The pointer will change to a double - headed arrow.  

▪ Click with the left mouse button and drag the double - headed arrow to 

the right to widen column A or to the left to make it narrower. 

See Microsoft video: Resize rows and columns. 

Most templates on InvoicingTemplates.com are printable / fit into one page 

horizontally. Expanding a column width may break this. To fix this you may need 

to narrow other columns. 

Color schema and palette 

https://support.office.com/en-us/article/Video-Resize-rows-and-columns-2d73d527-2725-4bed-b199-9a981362b5f9
https://www.invoicingtemplate.com/printable.html
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Most template here on InvoicingTemplate.com adopt the new theme-based color 

scheme. To change a color theme, follow the steps below. 

▪ Push down the "Design Mode" button on the "Invoice" ribbon tab. 

▪ Go to Excel "Page Layout" ribbon tab. 

▪ In the "Themes" group, pull down "Themes" to choose a new theme (this 

changes colors, fonts and effects), or pull down "colors" to use a new 

group of colors. 

▪ To create a new theme color, pull down "Colors" and choose "Customize 

Colors". 

▪ Once done, exit design mode by clicking the "Design Mode" button on the 

"Invoice" ribbon tab again. 

▪ Save the template. 

If you are using an elder template that still uses palette colors, to replace a color 

with another one you have to adjust the color palette. To do this follow the steps 

below. 

▪ Push down the "Design Mode" button on the "Invoice" ribbon tab. 

▪ Click Excel menu "File", and then click "Options". 

▪ Click "Save". 

▪ Next to "Choose what colors will be seen in previous versions of Excel", 

click "Colors". 

▪ Click the color that you want to change - for example, the fourth on the 

last line, and then click "Modify". 

▪ Specify the new color. Click "OK" to close the "Colors" dialog box. 

▪ Click "OK" to close the "Colors" dialog box. Click "OK" again to close Excel 

"Options" dialog box. 

▪ Exit design mode by clicking the "Design Mode" button on the "Invoice" 

ribbon tab again. 

▪ Save the template. 

Currency symbols 

Invoice Manager for Excel itself is currency-neutral which means, with the default 

database configurations, it does not record currency symbols in the database, 

and you can change your template to show any currency symbol you like. 

Most templates here on InvoicingTemplate.com does not show currency symbols. 

To display a currency symbol, follow the steps below. 
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▪ Switch to design mode by pushing down the "Design Mode" button on 

the "Invoice" worksheet. 

▪ Select the cells (fields) for which you want to modify the currency symbol, 

by dragging your mouse to select multiple cells. You can also push CTRL 

key on keyboard and click each cell one by one. 

▪ Right-click one of the selected cell and choose "Format Cells". 

▪ From the "Number" tab, you can choose either "Currency" or "Accounting" 

from the Category list. Note that currency formats are used for general 

monetary values, use accounting formats to align decimal points in a 

column. 

▪ Once you have done setting currency symbols, exit design mode by 

clicking the "Design Mode" button again. 

▪ Save the template. 

For living / practical samples, visit Simple Sample - Using Currency Symbol. 

Inserting a new column 

In our day to day design work of invoice forms, it is noticed that inserting a new 

column to the printable form is not as easy as inserting a new row. This is 

because the horizontal space of the form is limited, and inserting a new column 

usually means rearranging / adjusting existing columns. On the contrast, inserting 

a new row usually does not expanding the one-page template to two pages. 

To adjust the existing columns to leave space for a new column or columns inside 

the printable invoice form, we first unmerge the existing column, such as the 

description column. Then select proper cells and execute the "Merge and Center" 

command again to create a less-wider "Description" column. 

Now you have a new / empty column created by narrowing the "Description" 

column. Name the cells on the empty column properly to map them to a 

database field. 

A step by step detailed example could be found at Simple Sample - Adding 

Discount Column. 

21. Custom Fields - Invoice Manager for 

Excel  

https://www.invoicingtemplate.com/simple-invoice-template-currency-symbol.html
https://www.invoicingtemplate.com/printable.html
https://www.invoicingtemplate.com/simple-sample-discount-column.html
https://www.invoicingtemplate.com/simple-sample-discount-column.html
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Contents 

Invoice Manager for Excel supports custom fields added to Customer, 

CustomerShipAddress, Product, Invoice Header and Invoice Body database tables.  

NOTE: INCORRECT USE OF CUSTOM FIELDS COULD DAMAGE YOUR 

DATABASE! So please backup your database before modifying it, and make sure 

that you understand what will happen when you add/modify/delete a field. 

Contact the service team of Invoice Manager for Excel if you are unsure of the 

results of a modification. 

▪ Introduction - What is custom field? 

▪ How to use custom field? 

o Map database field name to Excel cell / range name 

o Add custom field to "Customer" database table 

o Add custom field to "Invoice Header" database table 

o Add custom field to "Invoice Body" database table 

o Add custom field to "Product" database table 

o Rules for applying custom field default values 

▪ Additional resource 

▪ Questions and answers 

Introduction - What is custom field? 

A custom field is a user-added field that is not defined in the default database 

structure provided by Invoice Manager for Excel. 

For example, the default Customer database table does not have the "fax" field; 

you can add "fax" as a custom field. By adding "fax" as a custom field to the 

Customer database table, you essentially add a new column "fax" to the 
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Customer table, so that for each customer account you can store its fax number 

in the field. 

How to use custom field? 

The usage of custom field involves two parts - add it to database, map it to an 

Excel cell. 

Creating a custom field in database tables is much easy in Invoice Manager for 

Excel than in Excel Invoice Manager. Invoice Manager for Excel provides a built-in 

"Custom Field Manager" which could be opened by clicking the "Customer" 

button on the "Invoice" ribbon tab, and then click the "Custom Field" button on 

the toolbar.  

Map database field name to Excel cell / range name 

Once a custom field is created, how do I use it on the invoice form? For example, 

if you add a custom field "fax" to the "Customer" database table, how to make it 

appear on the invoice form on the location you like? 

The answer is simple and short - by define a cell name "oknFax". That is, the 

relationship between a database field and a cell is established by using cell 

names. 

If you add a custom field Fax to the Customer database table, and define a cell 

name oknFax for a cell, the customer's fax number is automatically filled into the 

oknFax cell when you pick up a customer by clicking the 'select a customer' icon 

button on the invoice form. 

The cell naming rule is also simple - just add the prefix 'okn' to the database field 

name. So for example if a database field is named Company, then the 

corresponding cell should be named oknCompany. 

Add custom field to "Customer" database table 

If the data you want to add to your invoicing program is an attribute or property 

of the client, the custom field should be defined in the "Customer" database 

table. For example, the customer's company name, or fax number. You can also 

define the corresponding cell / range name on the Excel invoice form. This 

enables you: 
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▪ When you click the "Save As New Customer" button on the "Invoice" 

worksheet, the new customer account is created and saved along with the 

information provided in the custom field, such as client's company name 

or fax number. 

▪ When you pick up a customer on creating invoices by using the in-cell 

pickup button, or by filling the customer# directly into the correct cell, the 

information stored in the custom field is shown on the sheet too. 

A step by step example on adding custom field to the "Customer" database table 

could be found at Consultant Template Sample - New Company Name Field. 

Add custom field to "Invoice Header" database table 

If you want to save the additional data along with an invoice when the "Save 

Invoice" button or the "Save To DB" button is clicked, and the data appears once 

for each invoice, the custom field should be defined in the "Invoice Header" 

database table (i.e. the table named "InvHdr" in the Access database). 

In the previous section we use "Client's Company Name" and "Fax Number" as an 

example of adding custom fields to the "Customer" database table. Since this 

type of data should be saved along with each invoice, so the custom field should 

be defined in the "Invoice Header" database table too. Visit the 

consultant.htmlConsultant Template Sample - New Company Name Field to find 

out how. 

As a comparison, let's consider a "discount" field: 

▪ Unlike "Company Name" and "Fax" number, "Discount" is not an attribute 

of a client, so that you don't want to fill it when picking up a customer. 

▪ The "Discount" information should be saved along with each invoice, so 

that you can restore an invoice completely once it is saved. 

▪ The "Discount" appears once for each invoice -- i.e. this is a discount 

applied to the entire invoice, not an invoiced item. 

So unlike the "Company Name" field that is added to both the "Customer" and 

the "Invoice Header" database tables, such a "Discount" field is added only to the 

"Invoice Header" database table, as shown on Simple Sample - Discount Amount 

Field. 

Add custom field to "Invoice Body" database table 

https://www.invoicingtemplate.com/consultant.html
https://www.invoicingtemplate.com/consultant.html
https://www.invoicingtemplate.com/simple-invoice-template-discount-amount.html
https://www.invoicingtemplate.com/simple-invoice-template-discount-amount.html
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If you don't want a "Discount" field applied to an entire invoice, but want to show 

discount in detail for each invoiced item, then you have to add the "Discount" as 

a column on the invoice detail section. This "discount" value, since it appears 

more than once for each invoice -- i.e. it appears once for each invoiced item, so 

it should be defined in the "Invoice Body" database table. An example could be 

found at Simple Sample - Adding Discount Column. 

Add custom field to "Product" database table 

If the additional column, as the "Discount" column shown in the previous 

example, should be loaded when you pick up products / items -- i.e. the 

additional data represents the property or attribute of a product. 

For example, for a clothing store, the "Size" information should be loaded and 

filled into the form along with unit price. So this field should be added to both 

the "Invoice Body" and "Product" table. A sample could be found at Clothing 

Store (Manufacturer) Invoice with Size Breakdown. 

The cell naming rules for the "Product" and "Invoice Body" database tables are a 

bit different. If you add a custom field "ItemSize" to the "Product" database table, 

on the invoice body of the invoice form, it appears as a column. You name the 

column of cells "oknItemSize_1", "oknItemSize_2", "oknItemSize_3", and so on. 

This way, if you pick up a product by clicking the 1st "select a product" icon 

button, the "ItemSize" information stored in the database will be filled into the 

"oknItemSize_1" cell; and if you click the 2nd "select a product" icon button, it is 

filled into "oknitemSize_2" cell. 

Rules for applying custom field default values 

Each custom field has a "Default Value" property. By default, the default value is 

empty. 

If you assign a non-empty default value, it is applied when a new record is 

created. In addition to that, the "default value" defined in the following database 

tables are filled into Excel sheet when you click "Clear & New" command: 

▪ Invoice Header 

▪ Quotation Header 

▪ Purchase Order Header 

▪ Customer 

▪ Supplier 

https://www.invoicingtemplate.com/simple-sample-discount-column.html
https://www.invoicingtemplate.com/clothing-invoice-template-size-breakdown.html
https://www.invoicingtemplate.com/clothing-invoice-template-size-breakdown.html
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The order of filling default values is that the default values in the "header" tables 

are filled first, and then the default values defined in "Customer" or "Supplier" are 

filled. So, for example if you click "Clear & New" on the "Invoice" worksheet: 

1. First, the default values of custom fields in the "Invoice Header" table are 

filled. 

2. Next, the default values of custom fields in the "Customer" table are filled. 

If there are custom fields that have the same name defined in both 

"Invoice Header" and "Customer", but they have different values, the 

default values defined in "Customer" overwrite default values defined in 

"Invoice Header". 

Additional Resource 

These documents were originally published on office-kit.com, and were written 

for Excel Invoice Manager. While Invoice Manager for Excel provides built-in 

Custom Field Manager that much simplify the usage of custom field, these 

documents still provides usable information. 

▪ Custom Field - Overview 

▪ Custom Field - Tutorial 

Questions and answers 

Can a custom field be used on the search bar? 

Yes. Once a custom field is added, for example to the Customer table, it appears 

on the search bar located on the Customers data list window. You can also make 

the custom field appear on the data list window by clicking the Columns button. 

A cell is correctly named, but the value is not filled when it is supposed to 

do? 

▪ Make sure the cell is unlocked. 

▪ Make sure the cell does not have a formula assigned. 

Why custom fields defined for the Invoice Header (InvHdr) and Invoice 

Body (InvBdy) database tables cannot be edited on the "Invoice Edit" 

window? 

https://www.invoicingtemplate.com/excelinvoicemanagerfreedownload.html
https://www.invoicingtemplate.com/software.html
https://www.invoicingtemplate.com/custom-field-overview.html
https://www.invoicingtemplate.com/custom-field-tutorial.html
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This is by design. While the custom fields defined in the "Customer", "Product", 

"CustomerShippingAddress" database tables are all editable on the 

corresponding "Edit" windows. the "Invoice Edit" window does not allow you to 

edit the value of a custom field.  

This is because many of the field values on the invoice form should be calculated 

based on the data pulled from the "Customer" and "Product" database tables. For 

example, a line total value is calculated from price and quantity. Only the invoice 

form knows how to do such calculations, and the "Invoice Edit" window is 

responsible for displaying those values only.  

If you need to change the value of a custom field created for the invoice header 

or invoice body database tables, simply use the "Edit In Excel" command, and 

then save the modified invoice using the "Save To DB" command on the "Invoice" 

worksheet. 

22. Advanced Database Field 

Customization 

The Advanced Database Field Customization tool allows you to alter the size of 

the standard database fields that are defined by the default Invoice Manager for 

Excel database configuration. It also allows you to change the text alignment 

option of the fields shown on the data list windows.  

Note : If you are not familiar with database, contact our service team before 

doing any modifications to the standard fields.  

Note : Modifying database fields incorrectly could damage the database and 

prevent Invoice Manager for Excel from functioning properly. It is highly 

recommended that you backup the database file before modifying the fields.  

If your template is connecting with an Access database, you can also backup the 

database file by firstly exit Microsoft Excel (and any other applications / programs 

that connect with the database, and then copy the database file using Windows 

Explorer.  
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(Figure taken on Windows 10)  

To open the Advanced Database Field Customization tool:  

▪ Open any data list window. For example, open the "Customers" data list 

window by clicking "Customers" on the "Invoice" ribbon tab.  

▪ Click "Custom Fields" on the toolbar. 

▪ Click "Advanced" to open the Advanced Database Field Customization 

tool.  

Unlike the "Custom Field Manager" tool, which shows only custom fields defined 

for each database table, the Advanced Database Field Customization tool 

shows all the fields, including standard fields.  

To change the size (or precision and scale) of a field: 

▪ Open the Advanced Database Field Customization window as detailed 

above.  

▪ Click the "Backup Database" button to backup your current database. This 

allows you to easily return to a working state whenever something goes 

wrong.  

▪ From the "Database table" list, choose the table you want to customize.  

▪ Double-click the field name for which you want to customize its type. This 

opens the "Customizing Field" window:  
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Modifying a standard field (Figure taken on Windows 10)  

▪ Set the field size for a text field, or precision / scale for a decimal field.  

▪ Click OK.  

Note that if you change the size of the text field, you may also need to change 

the data validation of the corresponding cell. For example, if you change the size 

of customer name field to 80, to change the data validation of the Excel cell, 

follow the steps below.  

▪ When the Invoice worksheet is active, push the "Design Mode" button on 

the "Invoice" ribbon tab.  

▪ Click and choose the customer name cell that is named "oknWhoName".  

▪ Go to "Data" Excel ribbon tab, and then click "Data Validation" in the "Data 

Tools" group.  

▪ Specify the new validation - for this example, you just need to modify the 

"Maximum" field to be 80.  

▪ Exit design mode.  

▪ Save the invoice template.  

23. License Key 

The trial version of Invoice Manager for Excel is fully functional within 30 days. If 

you like it and need to keep it after the trial period, purchase a license key on our 

web site: 

http://www.uniformsoft.com/buy.html 

Or, 

http://www.uniformsoft.com/buy.html


 

INVOICE MANAGER FOR EXCEL   INVOICINGTEMPLATE.COM 

102 

https://www.InvoicingTemplate.com/buy.html 

Upon successful purchase, the license key(s) will be sent you via email. You can 

then enter the license key into Invoice Manager for Excel to unlock the trial 

version so that it will never expire again. 

1. Open any invoice template as usual. 

2. Click the About button on the Invoice ribbon tab. 

3. Enter the name and license key (or sometimes called registration code). 

4. Click 'Activate This License Key'. 

5. Restart Excel.  

6. Click the About button again. If the dialog box shows 'This product is 

licensed to <your license name>', then the license key is successfully 

activated and the trial version is unlocked. 

24. Cell Name Reference 

"Customer" database table 

When you click the Customer-Selection icon button on the Excel sheet and select 

a customer, certain fields in the Customer table are written to the Invoice 

worksheet. The following chart shows you all field names and their matching cell 

names.  

Field Name Cell Name 

CustomerId oknWhoID 

CustomerName oknWhoName 

Address oknWhoAddress 

Phone oknWhoPhone 

Country oknWhoCountry 

Email oknWhoEmail 

AccountBalance oknAccountBalance 

CityState, Zip oknWhoCityStateZip 

Credit oknCredit 

AccountBalance oknAccountBalance 

Category oknWhoCategory 

(All custom fields) okn(Field Name) 

https://www.invoicingtemplate.com/buy.html
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"Product" table 

When you click the Product-Selection icon button and select a product, certain 

fields in the Product table are written to the Invoice worksheet. The following 

chart shows you all field names and their matching cell names. ("**" in the chart 

indicates line number in the invoide body.)  

Field Name Cell Name 

ProductID oknProductID_** 

ProductName oknProductName_** 

Price oknPrice_** 

Cost oknCost_** 

Taxable oknTaxable_** 

(All custom fields) okn(Field Name)_** 

Cell name prefixes 

In Excel Invoice Manager, cells on the worksheets are identified by names. This 

design allows you to move the cells to a proper position you like. Each worksheet 

has its own predefined cell name prefix.  

Worksheet Cell Name Prefix 

Invoice okn 

Sales Report oknRs 

Customer Report oknRc 

Product Report oknRp 

Customer Statement oknCs 

Sales Rep. Report oknRr 

Payment Report oknPr 
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